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Gerenciamento de Referéncias — EndNote Deskiop
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— do SciELO
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E N DN OTE) s Gerenciando duplicatas

Gerenciando arquivos

EndNote Desktop EndNote Desktop

Como instalar Sincronizando sua conta
®
1. Fazer cadastro em: www.endnote.com
; . . i Essa tela aparece
2. Apds receber o link por e-mail, fazer download da | . P
~ . automaticamente
versdo 30-day frial.
durante a
3. A extens@o para o Microsoft Word, Cite While You instalagdo, mas
Write, é instalada automaticamente. pode ser
* O CWYW ¢ adicionado & barra de ferramentas do Word acessada
como um link que dé acesso direto a suas referéncias enquanto posteriormente
vocé escreve trabalhos no Microsoft Word. em: Edit >
* O CWYW permite a vocé fazer a formatagéo da bibliografia Preferences >
para o documento que estd paralelamente aberto no Word. Sync
b Ontnts | | Pevo Pore Corole



http://www.endnote.com/
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EndNote Desktop

Exportando referéncias do Web of Science

TEurO ESTRULIO

EndNote Desktop

Exportando referéncias do Web of Science

EndNote Desktop

Exportando referéncias do Web of Science

| Enviar para EndNote

Namero de ® Todos a1 regetros na pigina
registron:

Gravar conteddor |1

| Enwiar para Endbiote
Wumers de ) Todos 03 regstios na pigna O Web of Science s6

aceita que seja
— exportado de 500 em

500 registros.

Oravar contesdor [four

EndNote Desktop
Exportando referéncias do Web of Science

Enviando os registros para o EndNote

P smarte. sol
Envar
%
f Research:
90 15 Common Bpert Format
gr'j’d de: Wt/ /ets-webofknowledge €215 periodicos.capes.gov.be SerocT
R |0 it
® fbes como: ResawrchSolt Direct Export Helpes(apbcati.. -
Direct O Qownioad fstered Firm
BB 0 oo ductop e oo e v -
oertl
Cancelar
Assess supply cn

EndNote Desktop
Exportando referéncias do SciELO

@ Ssbew 0 ScELO
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EndNote Desktop

Exportando referéncias do SciELO

EndNote Desktop

Exportando referéncias do SciELO

Exportar resultados

EndNote Desktop

Exportando referéncias do SciELO

Exportar resultados

Abre

Formate
Vock seleconoy sbee

exporttxt
tipe: Test Document
tx de: b/ /vapnch scinlo ooy

W O que o Firefon deve fazes
Exporart Sber com o Bloce de notas (aphcatne padric)

Estd ® Domnicad

Rl [ Memorizar a decisdo para este lipo de aequeve

EndNote Desktop

Adicionando arquivos

1. Clique em File > New > D& um nome & sua biblioteca

@ trdbicte it
Fle Gt Refererces Groups Tools Window Helo

ey
ibrary. i S0

EndNote Desktop

Adicionando arquivos

1. Clique em File > New = Dé& um nome & sua biblioteca

EndNote Desktop
Adicionando arquivos
2. Antes de realizar a importagéo dos arquivos das bases

utilizadas, devemos organizd-los criando uma estrutura
de grupos subdivididos em pastas.

3. No exemplo, existem dois grupos (Bases e Filtros) com
suas pastas.

4. Com o botdo direito do mouse, clique em My Groups >
New Group Set > Nomeie o grupo como “Bases”.

5. Faga o mesmo para criar o grupo “Filtros”.
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EndNote Desktop

Adicionando arquivos

@ EndNote X8
File Edit References Groups Tools Window Help

© My EndNote Library
[ ® [ Annctatea s E

My Library

|[® @ awnor

B ANl References ©
@ Contgure sync..
D Recently Added ()]
B)unfiled ©
W Trash (U]

|
= Find Full Text

Create Smart Group
Creste From Groups.
Create Group Set
Rename Group Set
Delete Group Set

© EndNote xe

File Edit References Groups Tools Window
@ My EndNote Library

[ ® & amotstes .
My Library ® & Autho
BAN References (0]

&) Configure Sync.

D Recently Added (0]

Bl unfiled 0]

T Trash ]

= Bases
= Filtros

= Find Full Text

EndNote Desktop

Adicionando arquivos

6. Dentro do Group Set

Bases, crie grupos com
os nomes das bases
vtilizadas. No
exemplo,
grupos:

nosso
sdo quatro

* 01 - Web of Science
* 02 - SciELO

* 03 - Todos

* 04 - Néio duplicados

@ Endhote X8

File Edit References Groups Tools \

(2 All References ()
& Configure Sync...

4D Recently Added ©
B unfiled ©
T Trash ©

B 04 - Nao duplicados (0]

@ My EndNote Library
O @ ‘ Annotated
My Library

BE01 - Web of Science  (0)
Blj02- sciELo 0
B103 - Todes 0

EndNote Desktop

Adicionando arquivos

7. E dentro do Group Set
Filtros, crie os grupos:

* 05 - Titulo / Palavras-
chave / Resumo

* 06 - Néo disponiveis

* 07 - Disponiveis

@ EndNate X2

Fle Edit References Groups Tools Window F

@ My EndNote Library
[ ® 3| ammotsiea .
My Library

B an References L]

{& Canfigure Sync.

D Recently Added (L]

B Unfiled ©

W Trash @

= Bases
B 01 - Web of Science o
B2 - scieLo o
B)03 - Todos o
B 04 - Nz duplicados o
)05 - Tauko / Palavia-chave / Resuma (0]
BB} 06 - Disponiveis @

Nia dispeniveis

EndNote Desktop

Adicionando arquivos

8.

Agora, para importar
os arquivos das bases
Scopus e Web of
Science, clique em:
File = Import => File...

Escolha o arquivo e
clique em Import. ‘

@ Endhote X8

File Eda References Groups Tosls Window Help

Open Library.

Open Shared Library

Open Recent

Close Libeary
Sve 8 Copy
Share,

Impert

print Setup.

[
ComlsShifte 0 |

Compressed Library Lenls)

it

e

p—— T x
I r o |
== .

EndNote Desktop

Adicionando arquivos

* Todos os artigos importados irdo para a pasta All
references e deverdo ser copiados para as suas devidas
pastas (aquelas criadas dentro do Group Set Bases).

EndNote Desktop

Adicionando arquivos

* Outro modo de importar referéncias é selecionar o grupo
referente & base de dados (“O1 - Web of Science”, por

exemplo), e clicar no botdo de importar:

@ Erdtictexs

Fie Edit References Groups Tools Window Help

© My Endhone vy
01 ® [ | sonctsten -

Wyl

5 Pefeences @
3 ported Reterences o
& Gonfigure Syne.

Decenty sdded &
Bjuied @
T T ]

B0 Todus
104 o upicades o
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EndNote Desktop

Adicionando arquivos

EndNote Desktop

Adicionando arquivos

10.Apds copiar os arquivos para as suas devidas pastas
de “bases”, vocé deve uni-los na pasta “03 - Todos”.

11.Em seguida, copie os arquivos da pasta “03 - Todos”
para a pasta “04 - Néo duplicados”.

-
P B Refrences Gougs Todh Wandow bidp

I —

01 ® [ s e e EEICEIDLEE

Bjumies
hean

EndNote Desktop

Gerenciando duplicatas

12.Para eliminar as duplicatas, selecione todos os arquivos
da pasta “04 - Néo duplicados” e clique em References
-> Find Duplicates.

EndNote Desktop

Gerenciando duplicatas

* Caso encontre duplicatas, o EndNote ird realizar o
questionamento de qual das referéncias vocé quer
manter. Vocé deverd escolher a mais completa e clicar em
“Keep this record”.

EndNote Desktop

Gerenciando arquivos

*O Endnote® ndo acha automaticamente todos os
arquivos duplicados.

* Portanto, vocé terd que realizar uma filtragem manval
apds esse procedimento.

* Procure visualmente por duplicados e elimine-os
apertando a tecla delete.

* Ordenar por autor ou por titulo ajuda nas buscas por
duplicados.

EndNote Desktop

Gerenciando os filtros

1. Copie os artigos da pasta “03 - N&o duplicados” para
a pasta “05 - Titulo / Palavras-chave / Resumo”.

2. Em seguida leia os Titulos, as Palavras-chave e os
Resumos e delete os artigos que ndo estiverem
alinhados com o tema de sua pesquisa. Esse é o
primeiro filtro.

3. Copie todos os que restaram para a pasta “07 - Néo
disponiveis”.

4. Selecione todos os artigos da pasta “11 - Néo

disponiveis”, clique com o botdo direito e em Find full
text.
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EndNote Desktop

Gerenciando os filtros

© trdvenes
© My bt Loy

03 ® (%] somstees

Wiy

84 bt

EndNote Desktop

Gerenciando os filtros

* Os disponiveis irdo aparecer com um icone no formato de
um clipe:

Messuring Innovative Capacites of the Georgi..
Manpomer Development for the Biomedica 1.
Better off together: A cluster anslys of self-L.
ROSA. ROSAL, ROSIS: modeling a regionsl ope..
The role of multinationsl enterprises ia the 3.
The Impact of Knowledge Transfer n Indetry ..

Infhuencia de la capacidad de absorcida sobre L
INNOVATIVE ..

* Ordene clicando no clipe, selecione os disponiveis, isto &,
os que tiverem clipe, e mova-os para a pasta “06 -
Disponiveis”.

EndNote Desktop

Gerenciando os filtros

* Para os néo disponiveis é recomendado clicar na url, caso
disponivel, e tentar fazer o download, ou procurar pelo
artigo no Google académico, Google ou mesmo pelo
portal de Periédicos da Capes.

* Apdés as o termino das buscas, a andlise deve ser

realizada somente com os artigos que estiverem na pasta
“06 - Disponiveis”.

EndNote Desktop

Exportando os dados para andlise

Exportaremos os dados &t

File Edl Refwences Groups | Took Window Help

para uma planilha oo ]

T S . o
. = v
Excel. DG e o
. (s onesseen
1. Com a pasta “06 - Baivew | fomutwe 5
N f ey [t ChangeiMere/Capy Feds -
Disponiveis [T —— e
selecionada, clique | gia ope Tem s ,
8 e Termti. -
em Tools > Sub,ecf e ik Tem L. cuied
. (R
Bibliography... B wassincs |
Be-smn i
=
04 o duplicades Lisary Summary
-
1805 - Taule / Palavia-chan
207 Nbo disponiveis

EndNote Desktop

Exportando os dados para andlise

2. Selecione o parémetro desejado. Para o exemplo,
selecione Author e clique em OK.

Subject Felds x

Selected Feids: Select Al

[h" oo Selctionts)

{
i
!
=
| | Secondary Author
¥ | Secondary Tite
==
=
H | vokme
N |Musber of volumes
1=
e
# | Section
| ES e
o
i B | =
o Eustesh auther separatey
=
b e o ey s et ot i
d retum or ine feed. (Geywords entries are siways sted separately ) Felp

EndNote Desktop
Exportando os dados para andlise

3. Clique em Select All e em OK.

Subject Terms P

s shecorss o | [ sdectal J]
- Gear Selecten(s)
&
,
b > Cancel

77 Tem(e) Seected
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EndNote Desktop

Exportando os dados para andlise

4. Selecione um estilo (Output style), copie e cole o texto
no Excel.

P —— x

| Gactio i canecimentr m inchiia de ata fecnoiogin
82

Amoro, and M. Kun, dmovation, Entrapreneurship and Clusters is Lot
- Watura! Resiurce: ampicaion and Futire Chalnges Journsl o teehnology
management. bamp; inoovation, 2008. 3{4): p. 3243

| zni armin, Share (1)

FirdausRah, M., f al., 4 nabiorais Botechanlagy oulreach and uareness prageam for
Mty A Schos. ERITsHE Yol of BRAECNADY, 2005, BLL): B 1916

e prr reves, e e o

EndNote Desktop

Exportando os dados para andlise

5. Repita o procedimento para os pardmetros desejados:
palavras-chave, ano, periédico,...

6. Realize a andlise bibliométrica por meio do Excel.

Palavras-chave mais citadas

| |I‘I||||||||||||||||||||||||||||||l||||||||||||| |

EndNote Desktop
Cite While You Write

1. Quando quiser inserir uma citagdo no Microsoft Word,
comece a digitar o texto, clique na aba EndNote.

2. Selecione o estilo desejado (APA, ABNT, etc.).
3. Clique em Insert Citation.

Piginalnidal  Inserr layoutdaPigina _ Referéncias __ Comespondéndas  Revisio  Exibicio

£ Cotegorize References - Export
aste Citians and Eiooorapny Instant Formatting s OFt + | = preferences

@ 6o to Endilote Shle  Numbered
B Edit & Manage Citation()

R ot brary Reterencets) | [ Convert Citations and Bibliography - @ e
G sibliography . Tools

EndNote Desktop
Cite While You Write

4. Digite no campo de busca o nome do autor ou o ano
do artigo, clique em Find ou dé enter.

Endbicee X8 Find & Insent My References x
Authr Tew Tite
cancal e
Lbrarys Sitemsmiat h

EndNote Desktop
Cite While You Write

5. Selecione a referéncia e clique em Insert.

Qusrrs: Prom Theey o Procace, the ok of Tedhogy Gotebeeper, idsrstandng Dot

Ly T Lbrary et

mar s Blegraghy Only

EndNote Desktop
Cite While You Write

* O EndNote insere a citagdo e a ferramenta Cite While
You Write formata e adiciona & lista de referéncias no
fim do documento:

This is an example (Albors-Garrigos & Hervas-Oliver, 2014].

According to Belso-Martinez (2015), this is another example.

References

Creative Destruction in Clusters: From Theory to Practice,
the Role of Technology G jerstanding Disruptive Innovation in Indu
F. Kocaoglu, T. R. Anderson, . D. €. Kozanoglu, K. Niwa, & G. Perman (Eds.),

Conference on of Engil & Technology (pp. 710-722). New York:

Albors-Garrigos, 1., & Hervas-Olives

lece.

Belso-Martinez, J. A. {2015). Resources, Governance, and Knowledge Transfer in Spanish Footwear Clusters
Can Local Firms be Locked Out by Their Crucial Partner? International Regional Science Review, 38{2),
202-231. dol:10.1177/0160017612450709
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EndNote Desktop
Cite While You Write

* Para mudar o estilo de todas as citagdes do documento,
selecione o novo estilo, e clique em Update Citations and
Bibliography.

[ riove s e lsyowtcaigna  Referincas  Comespondéndas  Reisis  Exbicle | Enailotex
[R @ SR r— 1 caregoris Reterences - 4 partto Endiiote -
3 et & Manage citationts) | (5! Update Ctations and bibtiography | [E] nstant Formatting s Oft + | = preferences
o . [} Edit Ubrary Referencels) | BT, Convert Ctations and BIBTgraphy ~ @ e
Citations Bibliography Tools

EndNote Desktop
Cite While You Write

* Se vocé quer fazer uma mudanga para uma citagdo
individual, clique na citagdo e use o comando Edit &
Manage Citation(s).

EEERN rionenica e Lyoutdaigina  Referéncas  Comespondéncas  Revsdo  Edbicio | Endiotes

@ Goto enanote styler Numberes - B Categorze References - 4]Ewport to Enaiote -

ait & Manage Citationts | [5} Update Citstions and Bibtiography | [@)imstant Formatting i Off ~ | 2= preferences
ctaston~ TR EaR Uorany Rererencet | R Convert Cations and sibliography = @ e

Citations Bibliography Tools

* O EndNote ird reformatar as citagdes dentro do texto e
gerar nova lista de referéncias baseada em suas
mudangas.

st Coaten 2

rormaring: [Daptey ax s e |

e

EndNote Desktop
Cite While You Write

* Para citar no padr&o da ABNT, vocé deve ir até o site do
EndNote para fazer download do estilo.

* Procure no Google por “EndNote ABNT author date”

¢ Link direto:
http://www.endnote.com/downloads/style /brazilian-
standard-organization-abnt-author-date

EndNote Desktop
Cite While You Write

* A lista de referéncias fica no padrdo ABNT, no entanto,
nas citagdes ao longo do texto, o nome dos autores entre
parénteses ndo fica em letras maitsculas.

* A alteragdo deve ser feita manualmente.

This is an example {Albors-Garrigos e Hervas-Oliver, 2014).
References

ALBORS-GARRIGOS, J.; HERVAS-OLIVER, J. L. Creative Destruction in Clusters: From Theory to Practice, the
Role of Technology Gatekeepers, Understanding Disruptive Innovation in Industrial Districts. In: KOCAOGLU,
D. FANDERSON, T. R, etal (Ed.). 2014 Portland ional Conf on of Engineeri
&Technology. New York: leee, 2014. p.710-722. (Portland ional Conference on of
Engineering and Technology). ISBN 978-1-890843-29-8.

EndNote Desktop
Cite While You Write

ATENGAO!

* Enquanto utilizamos o plugin Cite While You Write, o
documento  Word é um documento dindmico que
possibilita, por exemplo que utilizemos a funcdo Update
Citations and Bibliography, que altera o estilo de todas as

citagdes e referéncias.

EndNote Desktop
Cite While You Write

ATENCAO!
Para colocar as citagdes em letras MAIUSCULAS conforme
a ABNT, devemos:
1. Terminar de escrever todo o documento;
2. Salvar como um novo documento Word (que se torna
ndo dinémico);

3. Fazer as alteragdes manualmente.

IMPORTANTE: Esse procedimento é irreversivel. O plugin
do EndNote né&o reconhecerd mais as citagdes e as fungdes
do CWYW néo terdo mais efeito!



http://www.endnote.com/downloads/style/brazilian-standard-organization-abnt-author-date
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MENDELEY

Gerenciamento de Referéncias — Mendeley Desktop

1. Como instalar 9. My library

2. Adicionando arquivos para 10. Forma de visualizagéo de
o Mendeley documentos

3. Literature search 11. Editor de PDF

4. Mendeley suggest 12. Detalhes do documento

5. Pesquisa relacionada 13. Notas

6. Importando de outros 14. Contents
gerenciadores 15. Criar grupos

7. Sincronizando com outros 16.

. Minhas publicagdes
gerenciadores 171 B
8. Recursos da versé&o desktop ~° °g ov

Mendeley Desktop

Como instalar

1. Fazer cadastro em: www.mendeley.com
Fazer download da vers&o desktop

Fazer login e instalar plug-ins (Web Importer e MS
Word plugin)
* Instalando o Web Importer

] Mendeley Desktop
File Edit View Tools Help

- o Invite Colleagues

Add Fol Install Web Importer

Mendeley Uninstall M5 Word Plugin

S Literature Sea Check for Duplicates
[ Mendeley sug

Options

Mendeley Desktop

Como instalar
3. Fazer login e instalar plug-ins (Web Importer e MS

Word plugin)
* Instalando o Web Importer:

1. Download the browser extension 2. Save articles from supported sites

Mendeley Desktop

Como instalar

3. Fazer login e instalar plug-ins (Web Importer e MS
Word plugin)
* Instalando o Web Importer:

€ O b nios

©  wwwmendeleycom
( pedise autorzagio

€ Ona mendeley,com|

e mendeleycom

BT Eute e desea mtalar uma extensies na Firefo

Mendeley imparter

Cancelar

Mendeley Desktop

Como instalar

3. Fazer login e instalar plug-ins (Web Importer e MS
Word plugin)
* Instalando o MS Word Plugin :

2 Mendeley Desktop
File Edit View | Tools Help

6l- = Invite Colleagues
= Fol  install Wep Importer
HMendeley Uninstall MS Word Plugin

/7 UterstreSea Check for Duplicates
] Menceley sug

Options

[REEE  Correspondéncias  Revisio  Bxibir
de Fim + O Undo L) Insert Bibliography
»
adeRodepé T [ZRefresh B Open Mendeley
nse
Citation * Exportas~ Style: Journal of Clean... -
i Mendeley Cite-O-Matic



http://www.mendeley.com/
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Mendeley Desktop

Adicionando arquivos para o Mendeley

1. Arrastando manualmente um ou mais arquivos ou
pastas;
2. Waich folder - Permita nramramar nara A Mandalay
* e

Ahcarvar /nivar ag |l

Mendeley Desktop

Adicionando arquivos para o Mendeley

3. Add Entry Manualy - Nesta opgéio é possivel inserir
dados de um material manualmente.

Imgon

e g @hemmil.eom) v

Mendeley Desktop

Adicionando arquivos para o Mendeley

4. Web Importer - Importar quando estd navegando em
um site/bases de dados.

Mendeley Desktop

Adicionando arquivos para o Mendeley

5. Nas bases de dados SCOPUS e SCIELO a importagdo é
feita de forma direta:

~ Sy
-

Mendeley Desktop

Adicionando arquivos para o Mendele

6. Nas bases de dados SCOPUS e SCIELO a importagdo é
feita de forma direta:

& sunbielpen

B Crellliks

Mendeley Desktop
Adicionando arquivos para o Mendeley

7. Sincronizando o Mendeley Web com o Desktop.

=@
Felseed S heb

Create R

10
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Mendeley Desktop
Literature Search

B Mensely Destop
Hle it gew Jook Help

Men d e | e)’ De Skf6p O Mendeley sugeriré O Mendeley
Mendeley Suggest

alguns documentos também manda
baseado nos existentes para o seu e-mail
na sua biblioteca algumas sugestdes

Mendeley Desktop

Pesquisa relacionada

* Procurar na biblioteca de outros usudrios documentos
relacionados ao que vocé selecionou.

Mendeley Desktop
File Edit View Tools Help

a-mmc ®

Add Folders Related  Sync Help

Mendeley Desktop

Importando de outros gerenciadores

* BibTex, Zotero e EndNote (Versdes free e paga)

Mendeley Deskiop
Fie Edt View Tools Help

Ackd Fies. [
Adkd Folder... CtrbeShift=0
Watch Folder.

Ackd Entry Msnually

BT ("bib)
EndMote XML - EndMote v& X1 1o X3 [ami)
RIS - Research Information Systems [*1)

Rensme Document Fles... bt S i JT——

£ synchronize Libeary ) drectors'perceptons il
begp o, Helen Developing arelatorl

Sign Out (ulians_msg@hotmdcom) mavketng Usn s

W Lee, Choanas; Lee, Insemal capabses, exte

= Lol ook Baonres. e <hite o mchrnkay e

Mendeley Desktop
Sincronizando com outros gerenciadores (BibTex)

e — [ - o

o B Mew Twls el |
. Gomd Comeivak  FOgam  akbedFoi Iotrs  Connacton
al+ | = it Collzagues

Boren Expan retrences

Lt B irstal Vet Irporter 2 o o e s (0% o
enceler Unietal MAS Wisns Prsgin ) e i s
Jimrstreses Checkfor Duphcates oren synerg
Moy 5y BTN 3y b e o 5w BTN e 0 1 00 ) B SRS 1 s WSy OIS 1 P Dt
Dptions coecton o nct be 4.

o

[ S ——

[T —r—— [

st e o docments s matcaly gareraimd o th farmat Abrvea . To et i ks vy, i #
Cont ey e o o G

@ -

Mendeley Desktop
Recursos da vers@o Desktop

* Bola verde - significa que vocé néo leu/abrir as referéncias ainda.
* Estrela - favorito (na pasta de Favoritos o registro seré encontrado
mais facilmente).

* PDF - o Mendeley permite o anexo do arquivo da referencia
(Word, Power Point e PDF).

Qe wemwe. o Cuater Sstanabbty: Th o i Scmrces sty 213 Econamc wne
Development Q
@+ 8 ey Ovuhec Buking o colabaraton capublty o matarabity, bom Gao 010 Organaston 1313716
Feaharm, Ao €. Kidoe. 1. reamg s everage 8 3 atege seet Oveames
o O e, s s, ekt ey et margemert 4 Steraslty 12413016
Setanc; Saomone, Raberta. Lt and thadows Cmtrrend]

* Trash - Arquivos deletados

* Search - campo de busca interno.

Q-s

86

11
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Mendeley Desktop

Recursos da verséo Desktop

LAYOUT
. . . B Mendeley Desincy
1. Criar pastas e inserir Bl e
arquivos ol cllellelle
2. Needs review - Heniciey CP P —
referéncias que 1 e .
dados Hy Libeary =
possuem da 1 e
faltando. : e s
3. Unsorted - onde o » g i
q - [
ficam os documentos - : : R
“soltos” (que ndo <) o

estdo em pastas

Mendeley Desktop

Recursos da verséo Desktop

LAYOUT

Mendeley Desktop
My Library

o Opgi * somamess

Synchronization cptions

Wab Space usage

SwTme

Mendeley Desktop

Forma de visualizar documentos

B2 iendey Desiasp
1. Forma de visualizagdo
das referéncias (citagdo
e
e -
el

ou tabela)

2. Escolhendo o estilo de

Mendeley Desktop
Forma de visualizar documentos

3. Adicionando ¢ R

Ciraton Sty

rmated C 2 i

Q flatsnatary

urrent Opinion in E1
Ecosystem Heakh an

Energy, Sustamabilty

Enaranment, Develo
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